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1. GENERAL PRINCIPLES OF DOWNLOADING REFERENCES 

 
Many of the databases to which the AUT Library subscribes enable you to transfer 
references from a search result into your EndNote library without re-typing the 
information. This downloading process is also possible from the AUT Library 
Catalogue and from Google Scholar. 
 
There are two methods for downloading references from databases. The method to 
use depends on the database (or catalogue). 
 
 Direct Export 

This is the easier method and fortunately most databases now offer a direct 
export function. This involves selecting the relevant references from your search 
results and then using an Export or Download button (or similar) on the database 
screen to automatically transfer the selected references to the EndNote library of 
your choice. 

 
 Import Filter method 

This method involves a few more steps. First you select the relevant references 
from your search results and save them as a text file. You then import the text file 
into your open EndNote library through an appropriate filter. EndNote is supplied 
with a folder of numerous filters for use with specific databases. When the 
program is installed on your computer the filter folder is also loaded. In addition, 
where necessary you may download some filters from the AUT Library website: 
http://www.aut.ac.nz/library/information_skills/managing_information/endnote/filter
s.htm . 

 
To use these methods, you first need to have created an EndNote library. When you 
download references by either of these methods, you will initially see in your 
EndNote library window just the references you have downloaded. If you already had 
references in your library, they are still there but are not displayed until you click 
References >> Show All References (or click the All References group in EndNote 
X1). 
 
 

Important tip: 
When the references are downloaded into your EndNote library, you are advised to 
check each one carefully for accuracy. Sometimes there will be errors or omissions in 
the information transferred from the database results list. It is good practice to check 
and, if necessary, edit your incoming references while you still have the database (or 
catalogue) results list on your computer. 
 

 
Not all databases are compatible with EndNote although the major ones are. Full 
instructions for those databases from which you can download (by either method) are 
given in Section 2 of this guide. Instructions for each database start from the point at 
which you have searched the database and obtained a list of results. 
 
 

http://www.aut.ac.nz/library/information_skills/managing_information/endnote/filters.htm
http://www.aut.ac.nz/library/information_skills/managing_information/endnote/filters.htm
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2. DATABASE INSTRUCTIONS 

 

2.1 Annual Reviews              Direct Export 

Note: You can only download one reference at a time from a search across all or 
several reviews. However, you can download multiple references from the browse 
contents screen of an issue of an individual review title. 
 
Searching all reviews 
1. On the list of results, choose one reference and click the title. 
2. On the page displaying the abstract, under the heading Quick Links, click 

Download to citation manager. 
3. The Download chapter metadata page opens. From the box at the bottom of the 

page select the following: 
 Include: Citation and Abstract for this article 
 Citation manager or file format: EndNote 
 Enable quick import into citation manager: Make sure the box is 

checked. 
4. Click the Download chapter metadata button: 

. 
5. On the File Download dialog box, click Open. 
6. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the reference. Double-click on it and the reference will be 
downloaded. 

7. You need to repeat these steps for each reference you wish to download. 
 
Browsing in an individual review 
1. On the list of results, mark relevant references by clicking in the tick box at the left 

of each result. 
2. Click on Download to Citation Manager:  above the 

results. 
3. The Download chapter metadata page opens. From the box at the bottom of the 

page select the following: 
 Include: Citation and Abstract for this article 
 Citation manager or file format: EndNote 
 Enable quick import into citation manager: Make sure the box is 

checked. 
4. Click the Download chapter metadata button: 

. 
5. On the File Download dialog box, click Open. 
6. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double-click on it and the references will be 
downloaded. 

 

2.2 Art Full Text and Art Index Retrospective          Direct Export 

1. On the list of results, mark relevant references by clicking in the tick box at the left 
of each result. 

2. Click on the Print Email Save button.  
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3. Click on the plus box next to Export to bibliographic software: EndNote, 

RefWorks: . 
4. Under Download Record(s) into: select The EndNote Filter. 

5. Click the Export button . 
6. A new window opens and the file download begins. 
7. On the File Download dialog box, click Open. 
8. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double click on it. 
9. You may be asked to select the filter you want to use. From the list which opens, 

select WilsonWeb and double-click on it.  
10. The references will be downloaded. 
 

2.3 ARTstor               Direct Export 

1. Select individual images with a single click. In the ARTstor navigation bar 
2. Click Tools > Save citations for selected images.  
3. A confirmation message appears confirming the citations were saved.  
4. To review what you’ve selected, click Tools > View and export citations. A new 

browser window will open displaying your saved citations as well as image 
thumbnails. Select the images you would like to export as bibliographic citations 
by checking the box above each image.  

5.  At the top of the Saved citations page select: 
 Export to EndNote, ProCite, or Reference Manager   

6. Dialog box opens.  
7. From the dropdown many chose: Open with EndNote EXE and click OK 
8. Select EndNote Library in to which you wish to download the references 
9. Dialog box open: Chose an import filter; click on ARTstor  and then click on 

Choose button 
10. The references will be downloaded. 
 

2.4 AUT Library catalogue           Import Filter: AUTvoyager 

1. On the list of results, mark relevant references by clicking in the tick box at the left 
of each result. You can choose references from more than one page of results. 

2. Click the    button. 
3. From the drop down box choose EndNote Citation. 

 
 

4. Click the  button. 
5. On the next screen click on File – Save As… 
6. The Save Webpage dialog opens. Make the following selections: 

 Change the location in the Save in: box to show the location in which to 
save your file. Desktop is a good choice as this file is only needed 
temporarily. 

 If you wish, rename your file. The default filename is exportRecord_do. 
 From the drop-down box next to Save as type: select Text Document 

(*.txt). 
 Click the Save button. 

7. Now open or switch to your existing EndNote library. 
8. Click File then Import. 
9. The Import dialog box opens. Make the following selections: 

http://help.artstor.org/wiki/index.php/Citing#Export_to_EndNote.2C_ProCite.2C_or_Reference_Manager
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 Click the Choose File button and navigate to the Desktop (or another 
location in which you saved the text file). 

 Select the text file that you saved from the catalogue and double-click it. 
 Click the Import Option drop-down box and click Other Filters. 
 The Choose An Import Filter dialog box opens. Scroll down and select 

the AUTvoyager filter. Highlight it and click the Choose button. 
Note: If you cannot find the AUTvoyager filter you will have to download it 
from the Library web site. See Appendix A for instructions on downloading 
filters. 

 Select an option from the Duplicates list. (A record is considered a 
duplicate if the author, year, title and reference type match a reference 
already in the EndNote library.) 

 The Text Translation box should say No Translation. 
10. Click the Import button to download the references to the EndNote Library. 
 
Note: Some fields may not be downloaded correctly so check these carefully and edit 
as necessary. Fields that are likely to need attention include: Author, Editor, Year, 
Publisher and City (publisher location). 
 

2.5 BMJ Publishing Group Journals          Direct Export 

1. On the list of results, mark relevant references by clicking in the tick box at the left 
of each result. 

2. Above the search results, click the radio button next to download to citation 

manager and click the Go button: . 
3. A new page opens. Click Download ALL Selected Citations to Citation Manager 

. 

4. On the next window, click EndNote: . 
5. On the File Download dialog box, click Open. 
6. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double-click on it and the references will be 
downloaded. 

 

2.6 CSA databases         Import Filter: various 

Note: CSA databases which work with EndNote include Abstracts in New Technology 
and Engineering (ANTE), Aquatic Sciences and Fisheries Abstracts (ASFA), Art 
Bibliographies Modern, Avery Index to Architectural Periodicals, Communication 
Abstracts, Communication Studies, Conference Papers Index, Criminology, Design 
and Applied Arts Index (DAAI), Education, Environmental Science & Pollution 
Management, Health Studies, Management & Organization Studies, Materials 
Science, METADEX, MLA International Bibliography, Political Science, Psychology, 
Sage Full Text Collections, Social Services Abstracts, Sociological Abstracts, 
Sociology, Toxline. Because of the variable nature of CSA indexing, downloaded 
citations should be checked for accuracy and completeness. 
 
1. On the list of results, mark relevant references by clicking in the tick box at the left 

of each result. 
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2. Click on the Save/Print/Email Records button  above the results 
list. 

3. Select Full Format from the drop down box. 

4. Click on the Save button: . 
5. On the File Download dialog box, click Save. 
6. On the next screen click on File – Save As… 
7. The Save Web dialog box opens. Make the following selections: 

 Change the location in the Save in: box to show the location in which to 
save your file. Desktop is a good choice as this file is only needed 
temporarily. 

 If you wish, rename your file. The default filename is csaresults. 
 From the drop-down box next to Save as type: select Text Document 

(*.txt). 
 Click the Save button. 

8. Now open or switch to your existing EndNote library. 
9. Click File then Import. 
10. The Import dialog box opens. Make the following selections: 

 Click the Choose File button and navigate to the Desktop (or another 
location in which you saved the text file). 

 Select the text file that you saved from the database and double-click it. 
 Click the Import Option drop-down box and click Other Filters. 
 The Choose An Import Filter dialog box opens. Select the appropriate 

filter as follows: 
 
Database Filter 

ANTE ASFA (CSA) 

Art Bibliographies Modern ARTbiblio Modern (CSA) 

ASFA ASFA (CSA) 

Avery Index to Architectural Per. Avery Index (CSA) 

Communication Abstracts Comm Abs (CSA) 

Communication Studies Comm Studies (CSA) 

Conference Papers Index Conf Papers Index (CSA) 

Criminology Criminology (CSA) 

DAAI Design App Arts Index (CSA) 

Education Education (CSA) 

Environmental Science & Pollution 
Management 

Environmental Sci (CSA) 

Health Studies Comm Studies (CSA) 

Management & Organization Studies Mgt and Org Studies (CSA) 

Materials Science Materials Science (CSA) 

METADEX METADEX (CSA) 

MLA International Bibliography MLA Intl Bib (CSA) 

Political Science Comm Studies (CSA) 

Psychology Comm Studies (CSA) 

Sage Full Text Collections Mgt and Org Studies (CSA) 
 

Social Services Abstracts Sociological Abs (CSA) 

Sociological Abstracts Sociological Abs (CSA) 

Sociology Comm Studies (CSA) 

Toxline Toxline (CSA) 

 
 Highlight the appropriate filter and click the Choose button. 
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 Select an option from the Duplicates list. (A record is considered a 
duplicate if the author, year, title and reference type match a reference 
already in the library.) 

 The Text Translation box should say No Translation. 
10. Click the Import button to download the references to the EndNote Library. 
 

2.7 EBSCOhost Databases           Direct Export 

(eg Academic Search Premier; Business Source Premier, CINAHL, MEDLINE, SPORTDiscus) 

1. On the list of results, mark relevant references by clicking the  link at 
the bottom of each result 

2. Click the  button on the right above the results. Folder  with item(s) 

looks like this: . 
3. On the Folder Contents page select item(s) for exporting by clicking in the tick box 

 or . 

4. Click Export:   above the results. 
5. Make sure there is no tick in the box next to Remove these items from folder 

after saving (not an essential step, but a good safeguard). 
6. Click the radio button beside Direct Export to EndNote, Procite, or Reference 

Manager. 
7. Click the Save button. 
8. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double-click on it and the references will be 
downloaded. 

 
Note: Some EBSCO references are imported into EndNote as “Generic” reference 
type. You may need to go through the references and correct the reference type. 
Some newspaper articles do not import correctly. 
 

2.8 Emerald Fulltext         Import filter: Emerald 

1. Conduct a search. 

2. Select items for the Marked List by checking the tick boxes  beside the items 
you wish to add to your list. 

3. Go to the top of the search results beside Select All and Add to the marked list 

 
pressing Go when you've chosen your list (Session marked list). 

4. Go to the left side of the page in Search and Browse and select Marked List. 

       

5. Scroll down the page to the Marked List and Select all  or those you 
wish to export to EndNote. 
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6. Go back to the top of the page and select Download  . 
7. This page is a webpage. In the browser navigation bar go to File>Save As 
8. Save as a plain text (.txt) to your Desktop (it won't work if you save it as a 

webpage). 
9. Now open or switch to your existing EndNote library. 
10. Click File then Import. 
11. The Import dialog box opens. Make the following selections: 

 Click the Choose File button and navigate to the Desktop (or another 
location in which you saved the text file). 

 Select the text file that you saved from Emerald and double-click it. 
 Click the Import Option drop-down box and click Other Filters. 
 The Choose An Import Filter dialog box opens. Scroll down and select 

the Emerald filter. Highlight it and click the Choose button. 
 Select an option from the Duplicates list. (A record is considered a 

duplicate if the author, year, title and reference type match a reference 
already in the library.) 

 The Text Translation box should say No Translation. 
12. Click the Import button to download the references to the EndNote Library. 
 
Note: Author names may not be downloaded correctly so check these carefully and 
edit as necessary. 
 

2.9 Engineering Village 2            Direct Export 

Note: Instructions apply to Compendex and Inspec databases only. 
 

1. On the list of results, mark relevant references by clicking in the tick box at the 
left of each result. 

2. Click the Download button  above the results list. 
3. In the Download Selected Records box: 

 Select  RIS, EndNote, ProCite, Reference Manager 

 

 Click the Download button . 
4. On the File Download dialog box, click Open. 
5. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double-click on it and the references will be 
downloaded. 

 

2.10 Google Scholar             Direct Export 

Note: You may only download one reference at a time from Google Scholar and you 
must set the correct preferences first. 

 

1. From the Google Scholar homepage, click Scholar Preferences.  
2. In the Bibliography Manager section, make selections as follows: 

 Click the radio button next to Show links to import citations into. 
 Change the drop-down box to EndNote. 

 Click the Save Preferences button: . 
3. Carry out your search. 
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4. On the results list, choose a relevant reference and click the link Import into 
EndNote link. 

5. On the File Download dialog box, click Open. 
6. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double-click on it and the reference will be 
downloaded. 

7. You need to repeat these steps for each reference you wish to download. 
 

2.11 IEEE Xplore              Direct Export 

1. On the list of results, mark relevant references by clicking in the tick box at the left 
of each result. 

2. Click the View Selected Items button  
3. In the Download Citations box (on the left of the page), make sure that the first 

drop-down box says Citation & Abstract and the second drop-down box says 
EndNote,ProCite,RefMan. 

4. Click the Download button . 
5. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double-click on it and the references will be 
downloaded. 

 

2.12 IIPA Full Text             Direct Export 

1. On the list of results, mark relevant references by clicking in the tick box at the 

bottom of each result.  

2. On the top left of the page, click Market list link   :  

3. Click on Download  link  
4. Click on Export directly to ProCite, EndNote or Reference Manager. 

     
5. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double-click on it and the references will be 
downloaded. 

 

2.13 Informit databases (A+ Education; APAFT)         Direct Export 

1. On the list of results, mark relevant references by clicking in the tick box at the 
left of each result. 

2. Click on Choose an action, choose Download Citation and then click on Go. 

      
3. Under Choose a Format, select EndNote Direct Export 

      
 

4. Under Choose detail required, select Citation and Abstract.  
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5. Under Choose delivery method, select Download file.  

      
6. Click Go. 
7. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double-click on it and the references will be 
downloaded. 

 

2.14 INNZ (Index New Zealand)               Import Filter: AUTINNZ 

1. On the list of results, mark relevant references by clicking in the tick box at the left 
of each result. 

2. To choose references from more than one page of results, click 

 before moving to the next page. 
3. Scroll to the Record Options section at the bottom of the page and choose the 

setting as follows: 
 In the Records section choose Selected All Pages. 
 In the Select Download Format: drop down box choose Citation 

Download. 

4. Click the Format for Print/Save button . 
5. On the next screen click on File – Save As… 
6. The Save Webpage dialog opens. Make the following selections: 

 Change the location in the Save in: box to show the location in which to 
save your file. Desktop is a good choice as this file is only needed 
temporarily. 

 If you wish, rename your file. The default filename is Pwebrecon. 
 From the drop-down box next to Save as type: select Text File (*.txt). 
 Click the Save button. 

7. Now open or switch to your existing EndNote library. 
8. Click File then Import. 
9. The Import dialog box opens. Make the following selections: 

 Click the Choose File button and navigate to the Desktop (or another 
location in which you saved the text file). 

 Select the text file that you saved from the database and double-click it. 
 Click the Import Option drop-down box and click Other Filters. 
 The Choose An Import Filter dialog box opens. Scroll down and select 

the AUTINNZ filter. Highlight it and click the Choose button. 
Note: If you cannot find the AUTINNZ filter you will have to download it 
from the Library web site. See Appendix A for instructions on downloading 
filters. 

 Select an option from the Duplicates list. (A record is considered a 
duplicate if the author, year, title and reference type match a reference 
already in the library.) 

 The Text Translation box should say No Translation. 
10. Click the Import button to download the references to the EndNote Library. 
 
Note: Some fields may not be downloaded correctly so check these carefully and edit 
as necessary. All downloaded references will have the reference type Journal Article 
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so you will need to change this to Newspaper Article or Magazine Article if 
appropriate. 
 

2.15 JSTOR              Direct Export 

Note:  Create a JSTOR account if you do not already have one.  
 
1. Conduct your search. 

2. Mark citations of interest by clicking in the tick box at the left of each result. 
3. Then click on save citation link 

 
4. Login to your JSTOR account. 
5. Click on MyJSTOR and then on Saved Citations.  

6. Click on Export this citations.  

7. Click on   
8. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double-click on it and the references will be 
downloaded. 

 

2.16 Leisure Tourism Database           Direct Export 

1. On the list of results, mark relevant references by clicking in the tick box at the left 
of each result. 

2. At the bottom of the page, click the Marked List: add button: . 
3. Click on the Marked List: view button. 
4. At the bottom of the page, use the drop-down boxes to modify the settings as 

follows: 
 Select Full Record 
 Select Tagged Text 
 Select EndNote 

 Click the Export button  
5. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double-click on it and the references will be 
downloaded. 

 

2.17 MEDLINE via PubMed       Import Filter: PubMed 

Note: PubMed references contain abbreviated journal titles. You should import the 
Medical Journal Titles term list into your EndNote library before exporting references 
from PubMed. Instructions for this are in Appendix C of the AUT University Library 
guide: Using EndNote X1 with Word 2007. 

1. On the list of results, mark relevant references by clicking in the tick box  at the 
left of each result. 

2. Change the drop-down menu after Display to MEDLINE, and change the Send 
to drop-down menu to Text: 

 
3. Once you select Text a new page opens. 
4. Click on File – Save As… 
5. The Save Webpage dialog box opens. Make the following selections: 
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 Change the location in the Save in: box to show the location in which to 
save your file. Desktop is a good choice as this file is only needed 
temporarily. 

 If you wish, rename your file. The default filename is entrez_htm. 
 From the drop-down box next to Save as type: select Text File (*.txt). 
 Click the Save button. 

 
Note: The save process will be different depending on your Internet browser and 
version. 
 
6. Now open or switch to your existing EndNote library. 
7. Click File then Import. 
8. The Import dialog box opens. Make the following selections: 

 Click the Choose File button and navigate to the Desktop (or another 
location in which you saved the text file). 

 Select the text file that you saved from the database and double-click it. 
 Click the Import Option drop-down box and click Other Filters. 
 The Choose An Import Filter dialog box opens. Scroll down and select 

the PubMed (NLM) filter. Highlight it and click the Choose button. 
 Select an option from the Duplicates list. (A record is considered a 

duplicate if the author, year, title and reference type match a reference 
already in the library.) 

 The Text Translation box should say No Translation. 
9. Click the Import button to download the references to the EndNote Library. 
 

2.18 OUP Journals             Direct Export 

Note: You can only download one reference at a time from an OUP Journals search 
result list. However, you can download multiple references from the browse contents 
screen of an individual journal title. 
 
Journals search 
1. On the list of results, choose one reference and click Abstract. 
2. On the page displaying the abstract, under the heading Services, click 

Download to citation manager.   

3. On the next window, click EndNote: . 
4. On the File Download dialog box, click Open. 
5. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the reference. Double-click on it and the reference will be 
downloaded. 

6. You need to repeat these steps for each reference you wish to download. 
 
Browsing in an individual journal 
1. Mark relevant references by clicking in the tick box at the left of each result. 
2. Above the search results, click the radio button next to download to citation 

manager and click the Go button: . 
3. A new page opens. Click Download ALL Selected Citations to Citation Manager 

. 

4. On the next window, click EndNote: . 
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5. On the File Download dialog box, click Open. 
6. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double-click on it and the references will be 
downloaded. 

 

2.19 OVID databases              Method depends on database 

Including AMED, Cochrane Library, ERIC, Essential Nursing Collection, Index to Foreign Legal 
Periodicals, Lippincott 100 Nursing and Health Science Collection, MEDLINE, PsycARTICLES and 
PsycINFO. 
 

Note:It is not currently possible to import references from HAPI, MMYB, 
Books@OVID or PsycBooks. 
 
1. On the list of results, mark relevant references by clicking in the tick box at the left 

of each result. 
2. Go to the Results Manager (above or below the results list). 
3. Once you have selected the references you wish to put in your EndNote library, it 

is very important to make the right choices in the Results Manager, as follows: 

 Results: Selected Results 

 Fields: Complete Reference 

 Citation Format: Direct Export 

 Click the Save button 
 

From this point there are 2 options for different databases: 
 
Option 1 (Direct Export) for these databases: 
AMED, Cochrane Library, ERIC, MEDLINE, PsycINFO 
The EndNote program opens. Select the existing EndNote library into which you 
wish to download the references. Double-click on it and the references will be 
downloaded. 

 
Option 2 (Simplified Import Filter method) for these databases: 
Essential Nursing Collection, Index to Foreign Legal Periodicals, Journals@OVID, 
Lippincott 100 Nursing and Health Science Collection, PsycARTICLES 
The EndNote program opens. Select the existing EndNote library into which you 
wish to download the references. Double-click on it. 
The EndNote Choose an Import Filter window opens. Locate the BIOSIS 
Previews (OVID) filter and click it once to select it. Click the Choose button. 
The selected references will be downloaded in to the EndNote library. 

 
Notes: (1) Data may be exported to the Type of Article field and should be deleted. 

(2) In some OVID databases the journal article title will include a modifier such 
as [Article]. This should be deleted from the EndNote record. 

 
 
 

2.20 Project MUSE             Direct Export 

1. On the list of results, mark relevant references by clicking in the tick box  at the 
left of each result. 

2. Click the Save Marked Results button: . 
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3. After the results have been saved, click Close Window  

4. Click on View Saved Results  link  
5. On the View Saved Results page make sure that the EndNote radio button is 

selected. 

 
6. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double-click on it and the references will be 
downloaded. 

 

2.21 ProQuest Databases (including ABI/Inform Global)        Direct Export 

1. On the list of results, mark relevant references by clicking in the tick box  at the 
left of each result. 

2. Click on Export   at the top of the results list. 
3. Click on Export directly to ProCite, EndNote or Reference Manager. 

 
4. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double-click on it and the references will be 
downloaded. 

 
Note: Author names may not be downloaded correctly so check these carefully and 
edit as necessary. In addition, only the start page number of an article will be 
entered. You will need to go back and check in the database record to ascertain the 
final page number (or wait until you have obtained the article in fulltext) and then 
enter this manually in the Pages field. 

 

2.22 ScienceDirect             Direct Export 

1. On the list of results, mark relevant references by clicking in the tick box  at the 
left of each result. 

2. Click Export Citations:  above the results list. 

3. The  page opens. For Content Format: select Citations + 
Abstracts. For Export Format: select RIS format (for Reference Manager, 
ProCite, EndNote). 

       

4. Click the Export  button: 
5. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double-click on it and the references will be 
downloaded. 
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2.23 Scopus              Direct Export 

1. On the list of results, mark relevant references by clicking in the tick box at the left 
of each result. 

2. Click the Output button:  above the results list. 
3. The Output page opens. Make the following selections: 

 In Section 1, click the radio button next to Export. 
 In Section 2, for Export format select RIS format (for Reference 

Manager, ProCite, EndNote) and for Output: select Abstract format. 
 
 

 Click the Export button: . 
5. On the File Download dialog box, click Open. 

4. On the File Download dialog box, click Open. 
5. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double-click on it and the references will be 
downloaded. 

 

2.24 Springer Journals             Direct Export 

1. On the list of results, mark relevant references by clicking the Add to marked 

items  link on the right of each reference. 

2. Click the Marked items  link on the left of the page. 

3. Click the Download icon:  above the list of references. 
4. On the next page, under the heading Export the citations from your current list 

of items, click on the RIS button: . 
5. On the File Download dialog box, click Open. 
6. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double-click on it and the references will be 
downloaded. 

 

2.25 Web of Knowledge Databases           Direct Export 

(Current Contents; MEDLINE, Web of Science) 

1. On the list of results, mark relevant references by clicking in the tick box  at the 
left of each result. 

2. On the bottom of the results page, under the heading , use the 
drop-down box to select : 
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3. Click the Save to… button:  

    

 
4. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double-click on it and the references will be 
downloaded. 

 
Alternatively, if you wish to select references from more than one page of the results: 
5. Mark relevant references as in Step 1 above. Click the Add To Marked List 

button:  
6. Repeat this on each page of results. 

7. Click the Marked List button at the top of the page:  
8. On the Marked Records page, make selections as follows: 

 In the Step 1 box select the fields you want to be imported into EndNote. It 
is advisable to include the fields already ticked as well as abstract and 
keywords. 

 In the Step 2 box make sure both drop-down boxes say Field Tagged. 

 Click the button. 
9. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double-click on it and the references will be 
downloaded. 

 

2.26 Wiley InterScience Journals           Direct Export 

1. On the list of results, mark relevant references by clicking in the tick box at the 
left of each result. 

2. Click on Download Selected Citations at the bottom of the page: 

. 
3. The Citation Export page opens. In the Format: drop-down box select EndNote. 

In the Export Type: drop-down box select Abstract and citation. 

4. Click the Go button . 
5. On the File Download dialog box, click Open. 
6. The EndNote program opens. Select the existing EndNote library into which you 

wish to download the references. Double-click on it and the references will be 
downloaded. 

 
Note: Author names may not be downloaded correctly so check these carefully and 
edit as necessary. 
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Appendix A: Instructions for downloading filters 

 
These instructions are for filters available on the AUT Library web site at: 
http://www.aut.ac.nz/library/information_skills/managing_information/endnote/filters.
htm 
 

 Right click on the filter link. 

 Choose Save Target As... (in Internet Explorer) or Save Link As... (in Firefox). 

 Locate the EndNote Filters folder. Usually this is C:\Program 
Files\EndNote\Filters\ . 

 Click the Save button. 

http://www.aut.ac.nz/library/information_skills/managing_information/endnote/filters.htm
http://www.aut.ac.nz/library/information_skills/managing_information/endnote/filters.htm

